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Chapter 1: Getting Started

Get inspired with Inspiration® 7, the premier tool to develop 
ideas and organize thinking. This guide is designed to help you 
get started using Inspiration, quickly and easily. It contains:

• What’s new in Inspiration 7

• System requirements

• Installation instructions

• Customer service information

• Introduction to Inspiration 

• Tutorial

Where to find more information
The Inspiration Help system contains detailed information about 
using Inspiration commands and features. The Inspiration User’s 
Manual is available as a PDF and contains all the information in 
the Help system.

• To access the Help system while you are using Inspiration, 
choose Inspiration Help on the Help menu.

• To view or print the Inspiration User’s Manual, see “Viewing 
and printing Inspiration documentation” on page 14.
1
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What’s new in Inspiration 7
Inspiration includes the following improvements and new 
features:

Inspiring new thinking tools

Visually integrated notes.  Begin the writing process while 
continuing to work in a visual format. Notes can now be included 
as an element in the diagram. Multiple notes can be viewed 
simultaneously and arranged as desired within the diagram. You 
can detach a note simply by dragging it away from its symbol and 
placing it anywhere in the diagram. Drop a note so it touches its 
symbol (or choose Reattach Note on the Symbol menu), and the 
note moves with its symbol. 

Hyperlink to any file. Gather and present information from 
multiple sources, including documents created in Inspiration or 
any other application, by hyperlinking to any file. This 
functionality replaces the Family feature found in earlier versions 
of Inspiration. Any child documents in an Inspiration 5 or 
Inspiration 6 file automatically convert to a hyperlinked 
document in Inspiration 7.

• Hyperlink button on the top toolbar

Add a hyperlink with just one click. This useful function is 
now right at your fingertips in both Diagram View and Outline 
View.

• Gather Hyperlinked Files

Manage and distribute complex documents with ease. The 
Gather Hyperlinked Files command creates one folder that 
contains a copy of the original file and a subfolder containing 
a copy of each hyperlinked file. You can find Gather 
Hyperlinked Files on the File menu.
Chapter 1: Getting Started



• Print hyperlinked documents

Print a document and all the hyperlinked Inspiration 
documents in one quick step. From the File menu, choose 
Page Setup, and select Hyperlinked Inspiration Documents.

• Search hyperlinked documents

For a quick and complete review, search a document and all 
Inspiration documents hyperlinked to it when using Find or 
Replace features. Find and Replace are found on the Tools 
menu.

Multiple main ideas. Brainstorm creatively and without 
limitation. When you switch from Diagram View to Outline View, 
an unlinked symbol appears as a topic at the main idea level 
rather than a miscellaneous thought.

Audio capabilities

• Record

Illustrate and expand the information in your document by 
recording audio and attaching it to a symbol or topic. Simply 
point to Sounds on the Tools menu and select Record. To play 

a recorded sound, click the Audio Quick Control  that 
appears by the symbol or topic.

• Listen 

Hear the computer read aloud any text in your work. When 
enabled in Application Properties, the Listen button appears 
on the top toolbar. 

Just click on any text in your document to hear it read. Choose 
from a variety of voices by pointing to Sound on the Tools 
menu and selecting Voices.
Inspiration® Getting Started Guide 3
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• Talking Interface

Hear the computer read the text in program menus and buttons 
by enabling the Talking Interface in Application Properties. 
You can choose from a variety of voices by selecting Voices 
under Sound on the Tools menu.

Inviting, intuitive interface

New interface design. Inviting colors and a friendly look, 
combined with an intuitive design, help you focus on completing 
the project at hand. 

Quick Controls. Efficiently manage information with easy 
access to notes, subtopics, and audio. Quick Controls appear 
automatically near the upper right corner of a symbol when you 
add a note, subtopic, or audio.

In Outline View, Quick Controls appear in control columns to the 
left of your outline. Just click the appropriate Quick Control to 
hide and show notes or subtopics, or to play recorded audio. 

Formatting toolbar. Instantaneously change colors, fonts, and 
styling. The Formatting toolbar is conveniently located at the 
bottom of the Inspiration window.

• Coloring model

Each color in a symbol appears on the Formatting toolbar. Just 
select the color you want to change and choose a new color 
from the palette. The coloring model includes fill and line 
color, as well as multicolor options.

Quick Controls

Line Color

Fill Color
Chapter 1: Getting Started



• Defaults for symbols, links, and notes

Quickly set the default look of symbols, links, and notes. If 
desired, you can then apply these settings to existing items in 

the diagram. The Defaults button  is found on the 
Formatting toolbar in Diagram View.

• Outline topic defaults

Customize the look of an outline by stylizing any topic level or 

notes text. The Topic Defaults button  is located on the 
Formatting toolbar in Outline View.

Multiple level undo. Try new ideas with confidence and 
flexibility. Undo and redo are always available on the Edit menu.

Simplified outlining. Efficiently manage information in the 
Outline View. Easy-to-read control columns to the left of the 
outline help you instantly see and manage subtopics, notes, and 
audio. Selecting and moving topics is also clearer with improved 
highlighting and feedback. 

Single create tool. Create linked symbols in any direction with 
a single tool, rather than the two tools in earlier versions of 
Inspiration. 

Link tool feedback. Receive immediate and continuous visual 
feedback as you create a link. 

Improved page setup. Set and preview your document 
margins, headers, and footers in a one-step process. Page Setup is 
found on the File menu.
Inspiration® Getting Started Guide 5
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• Diagram enlargements

Enlarge a diagram up to 10 times the original size to create 
bulletin board-sized printouts. You can scale the diagram to 
the number of pages you’d like using the Page Setup options 
found on the File menu. 

• Headers and footers

Fully customize with your own text or insert specific items 
such as time, date, or page numbers. Headers and footers are 
found in the Page Setup options on the File menu.

Independent grid settings. Show Grid and Snap to Grid 
function independently. On the Tools menu, choose Grid Settings, 
and then select or clear the check boxes.

Enhanced checklist feature

• Indented checklist

Check boxes  are aligned at each level in the hierarchy, 
making the checklist a more effective tool for managing 
multiple parts of a project.

• Sort option

Sort by the state of the check box associated with each topic. 
When you sort checklist items, topics at the level selected are 
rearranged with checked items first and unchecked items last.

Symbol shadow control. Shadows are now independent from 
line color. Symbol shadows can be turned on or off by choosing 
Shadow on the Symbol menu.
Chapter 1: Getting Started



Expanded prefix options

• Power outlining prefix

Display information at same level in the hierarchy as equal in 

importance. Click the Prefix button  on the Formatting 
toolbar and select Power Outlining.

• More prefix options

Begin prefix numbering at the main idea level. You can also 
turn off automatic sequencing to control the hierarchy of an 

outline. Click the Prefix button  on the Formatting 
toolbar and select Custom.

Open previews. When opening Inspiration documents, a small 
preview helps you identify the correct project.

Easily modified default settings. Quickly change defaults 
for Diagram View and Outline View, restore factory defaults, or 
select any template to be the default when you start Inspiration. 
To modify the program default settings, select Default Settings 
on the Utility menu. 

Flexible template functions

Template Wizard. Walk step-by-step through the process of 
creating and saving a template. To use the Template Wizard, select 
Template Wizard on the Utility menu.

Templates launch from any location. Save templates 
anywhere. This makes it easy to share and distribute them via 
email or by placing them on a server. In Windows®, templates 
appear with a .ist extension.

More than 50 built-in templates. A wealth of ideas from 
across the educational curriculum makes it easier than ever to 
integrate visual learning into the classroom. Select Open 
Template on the File menu to get started.
Inspiration® Getting Started Guide 7
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Rapid web site creation

Site Skeleton™ export. Build the “bones” of a new web site 
with the Site Skeleton export. Each symbol becomes a separate 
web page, complete with appropriate hyperlinks. Inspiration even 
creates a site map for you. These structured pages can then be 
finished and formatted using any web authoring tool. On the File 
menu, select Export as HTML, and choose Site Skeleton.

Refined HTML exports. Publish your diagrams or outlines as a 
web page with one of four comprehensive options. If desired, you 
can even make the background of your diagram transparent. 
Choose Export as HTML on the File menu.

Hyperlinked file exports. Broaden the scope of web pages 
created in Inspiration by hyperlinking to multiple Inspiration 
documents or files created in other applications.

Improved operational support

Save as Inspiration 6. Make Inspiration 7 documents 
available to Inspiration 6 users with this save option.

Kidspiration™ compatibility. Open Kidspiration files and 
easily convert them to Inspiration 7.

Better PowerPoint exports. Outlines convert to PowerPoint 
format more cleanly and intuitively, making Inspiration the 
perfect tool to plan your presentations. 

OS X compatibility. Inspiration 7 supports Macintosh® OS X 
as a carbonized application.

Multiuser support. In multiuser configurations on Macintosh 
or Windows, users can create their own set of preferences, 
dictionaries, symbol libraries, and other personalized options.
Chapter 1: Getting Started



Installing Inspiration
Before installing Inspiration, make sure your computer meets the 
following minimum requirements:

System requirements

Macintosh

• Macintosh or Power Macintosh

• System 7.1, 8.0, 9.0, OS X 

• 2 MB available RAM

• 640 x 480, 256 color display

• 5 MB available hard drive; 30 MB for full install

• CD-ROM drive (for installation only)

• Optional:

• Macintosh compatible printer 

• Internet browser

• Microphone

Windows

• 486 processor or higher

• Windows 95, 98, 2000, NT 4.0, ME, XP

• 8 MB RAM

• 640 x 480, 256 color display

• 5 MB available hard drive; 20 MB for full install

• CD-ROM drive (for installation only)

• Optional:

• Windows compatible printer 

• Internet browser

• Soundcard and speakers

• Microphone
Inspiration® Getting Started Guide 9
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About upgrading from an earlier version of 
Inspiration
When you install Inspiration 7, it does not overwrite any earlier 
version of Inspiration installed on your computer. This enables 
you to keep custom templates and custom symbol libraries 
created in the earlier version of Inspiration.

After you install Inspiration 7, you can copy custom templates 
and symbol libraries from the earlier version of Inspiration to the 
Inspiration 7 folder.

Copy symbol libraries from the earlier version of Inspiration to a 
folder inside the Inspiration Libraries folder. You can copy the 
libraries to an existing folder or to a folder you create. For 
example, you could create a new folder called “Inspiration 6 
Symbols.”

Copy templates from the earlier version of Inspiration to the 
Inspiration Templates folder inside the Inspiration 7 folder. After 
you copy the templates and libraries you want to keep, you can 
remove the earlier version of Inspiration from your computer.

Any files you created with Inspiration 5 or Inspiration 6 can be 
opened by Inspiration 7.
Chapter 1: Getting Started



Macintosh installation
1. Close all programs including screen saver and anti-virus 

programs.

2. Insert the Inspiration CD-ROM into your CD-ROM drive.

3. Double-click the icon for the Inspiration 7 CD-ROM, and then 
double-click the Inspiration 7 Install icon to install Inspiration. 
If you are using OS X, double-click Inspiration 7 Install OS X.

If necessary, the installer will ask to add the required text-to-
speech software to your computer. Click OK to install. After 
updating the computer’s system software, your computer will 
restart and automatically continue the Inspiration installation.

4. On the drop-down menu, select Easy Install or Custom Install:

• Select Easy Install to install the full Inspiration program, 
including symbols, templates, examples, and the Help 
system.

–or–

• Select Custom Install to selectively install Inspiration 
program components. Choose this option if you have 
limited hard disk space and you do not want to install the 
full Inspiration program. 

5. Follow the instructions on your screen to complete the 
installation process. A message appears when installation is 
complete.

6. Inspiration starts automatically and the Personalize Inspiration 
dialog appears.

Enter your name and/or organization and your serial number. 

Note:  Your serial number can be found on the CD-ROM 
sleeve. The serial number identifies your copy of Inspiration; it 
is required to personalize your Inspiration application. Click 
OK.

To register your copy of Inspiration, see “Registering Inspiration” 
on page 13.
Inspiration® Getting Started Guide 11
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Windows installation
1. Close all programs including screen saver and anti-virus 

programs.

2. Insert the Inspiration CD-ROM into your CD-ROM drive.

3. Double-click My Computer, and then double-click the icon for 
your CD-ROM drive.

4. Double-click the Install.exe icon to install Inspiration.

If necessary, the installer will ask to add the required text-to-
speech software to your computer. Click OK to install. After 
updating the computer’s system software, your computer will 
restart and automatically continue the Inspiration installation.

5. Select Easy Install or Custom Install:

• Select Easy Install to install the full Inspiration program, 
including symbols, templates, examples, and the Help 
system.

–or–

• Select Custom Install to selectively install Inspiration 
program components. Choose this option if you have 
limited hard disk space and you do not want to install the 
full Inspiration program.

6. Follow the instructions on your screen to complete the 
installation process. A message appears when installation is 
complete.

7. Inspiration starts automatically and the Personalize Inspiration 
dialog appears.

Enter your name and/or organization and your serial number. 

Note:  Your serial number can be found on the CD-ROM 
sleeve. The serial number identifies your copy of Inspiration; it 
is required to personalize your Inspiration application. Click 
OK.

To register your copy of Inspiration, see “Registering Inspiration” 
on page 13.
Chapter 1: Getting Started



Network installation
Refer to the network installation instructions provided with your 
volume license. Volume licenses are available from Inspiration 
Software, Inc. For more information, call 503-297-3004.

Registering Inspiration
If you purchased a single copy of Inspiration, you can register 
online or send in the printed registration card provided.

To register online, click Register Online after you personalize 
Inspiration. Your browser starts and opens Inspiration’s online 
registration form. Follow the on-screen instructions. (Note… You 
must have a modem and a browser installed to register online.) If 
you are unable to register online, please complete and mail the 
printed registration form.

To register a volume license, please complete and mail or fax the 
printed license agreement. 

When you register, you’re entitled to special benefits from 
Inspiration Software, Inc. As a registered customer, you receive:

• Free telephone, fax, and email technical support

• Substantial discounts on Inspiration upgrades

• Tips on using Inspiration

• Information about new products or updates

• Flashes, the Inspiration Software, Inc. newsletter

About Inspiration customer service
Inspiration Software, Inc. is committed to assisting our 
customers. If you have comments, questions, or need assistance 
while working with Inspiration, please contact us by email, 
telephone, or fax. You can also connect directly to Inspiration 
Technical Support by choosing Help on the Web on the Help 
menu.
Inspiration® Getting Started Guide 13
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Inspiration Software, Inc. provides free customer service and 
technical support for registered users. Be sure to register so you 
can take advantage of our support services.

When you contact us, please be prepared to provide your serial 
number. Our support services are open Monday through Friday 
from 8 a.m. to 5 p.m. Pacific Time. Please email us at 
techsupport@inspiration.com, or contact us by telephone at 
503-297-3004. You can also reach us by fax at 503-297-4676.

Viewing and printing Inspiration 
documentation

The Inspiration User’s Manual and other written documentation 
is available in the form of PDF files. To view or print this 
information, you need Adobe® Acrobat® Reader installed on 
your computer. If your computer does not have Acrobat Reader, 
you can download a free copy from Adobe at www.adobe.com.

To view or print Inspiration documentation on a 
Macintosh:

1. Double-click the Inspiration® 7 folder on your hard drive. 

2. Double-click the Inspiration Documentation folder to open it. 
The folder contains four PDFs: 

3. Double-click a PDF to view or print it.

Getting Started.pdf Getting Started Guide, 
including installation 
instructions and tutorial

Users Manual.pdf Inspiration User’s Manual

Symbol Guide.pdf Illustrated listing of all built-
in symbol libraries

Template Guide.pdf Overview of all built-in 
templates with instructions
Chapter 1: Getting Started



To view or print Inspiration documentation in 
Windows:

1. On the desktop, double-click My Computer.

2. In My Computer, double-click the icon for the drive where 
Inspiration is installed.

3. Double-click the Inspiration 7 folder to open it.

4. Double-click the Inspiration Documentation folder to open it. 
The folder contains four documents: 

5. Double-click a PDF to view or print it.

Removing Inspiration

Macintosh
Drag the Inspiration® 7 folder to the Trash, and then empty the 
Trash. 

Windows
1. Click the Start button, point to Settings, and then click Control 

Panel.

2. Double-click Add/Remove Programs.

3. Select Inspiration 7 in the list box, and then click Add/
Remove.

Getting Started.pdf Getting Started Guide, 
including installation 
instructions and tutorial

Users Manual.pdf Inspiration User’s Manual

Symbol Guide.pdf Illustrated listing of all built-
in symbol libraries

Template Guide.pdf Overview of all built-in 
templates with instructions
Inspiration® Getting Started Guide 15
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Chapter 2: Introducing 
Inspiration

In Inspiration, you think and learn visually. Inspiration allows you 
to create a picture of your ideas or concepts in the form of a 
diagram. It also provides an integrated outlining environment to 
develop your ideas into organized written documents. 
Inspiration’s combination of visual and linear thinking helps 
deepen understanding of concepts, increase memory retention, 
develop organizational skills, and tap creativity.

When you work with visual representations of ideas, you easily 
see how one idea relates to the others. Learning and thinking 
become active rather than passive. You discover where your 
deepest knowledge lies, and where the gaps in your 
understanding are. When you create a visual map of ideas, you 
can recall details better than if you had read a paragraph. That’s 
because you can see it in your mind. 

If you have an idea that you want to expand, whether it’s an idea 
for a written document or to map out a plan, Inspiration can help 
you organize your thoughts and save you time. Use the visual 
diagramming part of the program to work with your ideas, to 
arrange them and group them—in other words, to clarify your 
thinking.

When you need a different kind of structure, you can use the 
outlining part of the program to organize your ideas in a 
hierarchical form. Inspiration’s outlining environment is perfect 
for creating structure for written documents, speeches, and plans.
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About the Inspiration views
Inspiration has two main views or environments: Diagram View 
and Outline View. As you work, both keep track of your ideas. 
Sometimes you will work exclusively in Diagram View to create 
a graphical organizer or a map showing how ideas or concepts 
interconnect. Other times you will work in Outline View where 
you might organize and write a report.

Here’s what Diagram View looks like.

Symbol 
palette

Diagram 
toolbar Note

Subtopic or subpointFormatting toolbar

Starting point, main 
idea or central theme
Chapter 2: Introducing Inspiration



And here’s what Outline View looks like.

Uses of diagrams
In Inspiration, you can create many types of visual diagrams. It 
doesn’t matter if you’re planning a project, looking at cause and 
effect, or developing your understanding of a complex concept. 
The kind of diagram you create in Inspiration depends on the idea 
you want to develop. Here are some of the different types of 
diagrams you can easily build using Inspiration:

Outline 
toolbar

Selection
control column

Primary or main idea, 
or central topic

Notes text

Subtopic or 
subpoint

Subtopic
Quick

Control

Note
Quick

Control

Audio
Quick

Control

Formatting toolbar
Inspiration® Getting Started Guide 19
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Concept map
A concept map is a hierarchical diagram used to represent a set of 
concepts, beginning with the most general or most important, and 
then working down to more specific detail. Key concepts are 
connected by links that have descriptive words on them 
explaining the relationship between the concepts.

Concept maps are often used to illustrate scientific or historical 
concepts or for other types of knowledge mapping.

The Skin diagram is an example of a concept map.
Chapter 2: Introducing Inspiration



Idea map
An idea map is used to brainstorm ideas and develop thoughts. 
Idea maps start with the main idea or problem in the middle of the 
screen. You record ideas associated with this topic in symbols that 
radiate from it. The symbols connect to the main idea with links. 
Subtopics or specific details are then added to those ideas. You let 
the ideas flow and then step back and look at main themes, 
patterns, or possible solutions. 

Idea maps can be used for individual or group brainstorming, 
planning, problem solving, and report writing.

The Blue diagram is an example of an idea map.
Inspiration® Getting Started Guide 21
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Web
A web is a visual map that shows how different bits of 
information relate to each other. A web has a main idea or core 
concept at the center, with different categories of information 
connected to it. Ideas, facts, and information are connected to the 
categories to support them. 

Webbing is particularly useful when you’re analyzing a story, or 
brainstorming ideas for a plan or written report.

The Hatchet diagram is an example of a web.
Chapter 2: Introducing Inspiration



Storyboard
A storyboard is a visual way to organize projects such as 
multimedia presentations or the design of a web page. A 
storyboard helps you plan what you’re going to say and show, and 
figure out which ideas belong at the beginning, middle, and end. 
In a storyboard, each symbol can represent a different slide, 
screen, or page.

The Science Fair Web Site Plan diagram is an example of a storyboard.
Inspiration® Getting Started Guide 23



24
Uses of outlines
When you make an outline, you create a hierarchical structure for 
your ideas. An outline helps organize written documents, 
speeches, or plans by providing a framework for ideas, and by 
letting you order the flow of information.

You will find outlining particularly useful for planning and for 
structuring information when writing. While the structure of an 
outline is simple, outlines can help you organize very complex 
material. 
Chapter 2: Introducing Inspiration



Starting Inspiration
After you have your copy of Inspiration installed and 
personalized, you’re ready to get to work. Here’s how you open 
Inspiration.

To start Inspiration on a Macintosh:

• Open the folder that contains Inspiration, and then double-
click the Inspiration icon.

To start Inspiration on a computer running Windows: 

• Click the Start button, point to Programs, and click 
Inspiration 7.

Inspiration opens, and a new, untitled diagram appears on your 
screen. 
Inspiration® Getting Started Guide 25
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Chapter 3: Learning 
Inspiration, A Tutorial

This tutorial is a great starting point for learning how to use 
Inspiration. Please plan on about 45 minutes from start to finish.

If you’re new to Inspiration and like to learn while working on 
screen, this tutorial is for you. We have kept the information in 
small, manageable chunks to make it easy to learn the basics 
quickly. Before you know it, you’ll be using Inspiration to 
develop your own great ideas!

You use Inspiration the same way as most Mac OS and Windows 
programs. For example, as you work, you use the mouse to drag 
objects and to select text. You also click and double-click, as well 
as enter information using the keyboard. If you’re not 
comfortable doing these things, take a moment now and refer to 
the user’s guide that came with your computer.

Conventions we used
The tutorial has instructions for both Mac OS and Windows-
based computers. When you’re asked to press a key or click a 
command on a menu, the Mac OS instructions appear first, and 
the Windows instructions are in parentheses immediately 
afterward. Here are two examples: Press Return (Enter) and press 
the Command (Ctrl) key.

When you’re asked to enter specific text, the text you will type 
appears in bold. For example, Career Thoughts. When referring 
to a symbol or name you already entered, it appears in italics, like 
Career Thoughts.

And a special note…  Because people work in different ways, 
Inspiration offers many ways to do things—from toolbar buttons 
to menu commands to keyboard shortcuts. While these options 
are all readily available, this tutorial usually shows one way to do 
a task. By limiting the alternatives presented, we hope to make it 
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easier to learn the task. In the Help system and the Inspiration 
User’s Manual, you will find many ways to do each task, so you 
can pick the one that’s most comfortable for you. To access the 
Help system, see “Where to find more information” on page 1. To 
view or print the Inspiration User’s Manual, see “Viewing and 
printing Inspiration documentation” on page 14.

How we organized the tutorial
In the Inspiration tutorial, you follow a series of straightforward, 
step-by-step instructions to create a simple visual representation 
of an idea called a diagram. You also work with an outline, a text-
based, hierarchical display of the same idea.

The tutorial is organized in mini-lessons. They’re designed to be 
completed in order, but you don’t need to do them all at one time. 
Each mini-lesson introduces you to several of the unique features 
in Inspiration. When you finish the tutorial, you will be ready to 
create diagrams and outlines on your own. 
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Mini-Lesson One: Getting Started
This tutorial models a possible student brainstorm about career 
thoughts. 

In the first mini-lesson, you will learn the following:

• How to open Inspiration

• How to enter a main idea for your diagram

• How to use the Create tool to add symbols

• How to use the RapidFire™ tool to add symbols

• How to use point and type to add an unconnected symbol

• How to replace a symbol with one from the Symbol palette

• How to use drag and drop to add a new symbol from the 
Symbol palette

• How to use the Link tool to link symbols

• How to add text on a link

• How to add a note to a symbol

• How to move a note

• How to move symbols

• How to change the colors of a symbol

• How to save an Inspiration document

Starting Inspiration

To start Inspiration on a Macintosh: 

• Open the folder that contains Inspiration, and double-click the 
Inspiration icon.

Inspiration opens a new, untitled diagram.
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To start Inspiration in Windows:

• Click the Start button, point to Programs, and click 
Inspiration 7.

Inspiration opens a new, untitled diagram.

Note:  Before you can start the program, Inspiration needs to be 
installed. If you haven’t installed Inspiration on your computer 
yet, see “Installing Inspiration” on page 9.

Introducing Diagram View
Inspiration opens in Diagram View where you process, organize, 
and prioritize information visually. Key functions are right at 
your fingertips with the Diagram toolbar along the top, the 
Formatting toolbar at the bottom, and the Symbol palette on the 
left.

Diagram toolbar

Formatting toolbar

Symbol palette

Main Idea symbol
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Entering the main idea or topic
When you open Inspiration, a symbol appears in the center of the 
screen, with the placeholder text, Main Idea, selected. It’s easy to 
get started—just enter a topic. 

• Type the diagram topic, Career Thoughts, into the Main Idea 
symbol.

Using the Create tool to add a new linked 
symbol
There are many different ways to create new symbols in Diagram 
View. An easy way to add a linked symbol is to use the Create 
tool. The Create tool adds a new linked symbol in the direction 
you choose.

1. Select the Career Thoughts symbol. On the Diagram toolbar, 
position the cursor over the upper right point on the Create 
button.

When you roll over a point on the Create button, it highlights 
to show the direction in which the new symbol will be created.

2. Click the upper right point. A new symbol appears connected 
to and diagonally above the Career Thoughts symbol. This 
symbol is selected and ready for you to enter an idea. 

3. Type Enjoy my job into the new symbol.

Trying it again
Now use the Create tool again to add a second linked symbol.

1. Select the Career Thoughts symbol. 

This time, you’ll notice there’s a Subtopic Quick Control  
near the upper right corner of the symbol. The Subtopic Quick 
Control appears next to a symbol to show that it has a sub-
topic.

Click the upper right point to create a 
new, linked symbol in that direction.
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2. On the Diagram toolbar, position the cursor over the lower left 
point on the Create button.

3. Click the lower left point.

The new symbol appears connected to and diagonally below 
the Career Thoughts symbol.

4. Type Things I like to do into the new symbol.

5. Press Shift+Return (Shift+Enter) to end text entry and select 
the symbol.

Here’s what the diagram looks like now.

Using the RapidFire tool to quickly capture 
ideas
You’re going to use the RapidFire tool to brainstorm things you 
like to do. The RapidFire tool adds a series of linked ideas to a 
symbol. This allows you to concentrate on entering information, 
rather than creating symbols one at a time. 

Click the lower left point to create a 
new, linked symbol in that direction.
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RapidFire places ideas in a freeform structure. There’s no need to 
think about organizing yet; you’re still getting ideas down to 
“see” what you think. You’ll learn more about organizing the 
information later in this tutorial.

1. Select the Things I like to do symbol, if it’s not already 
selected. On the Diagram toolbar, click the RapidFire button.

The RapidFire icon appears in the symbol to show the tool is 
turned on.

2. Type Fix things and press Return (Enter).

3. Type Tinker with cars and press Return (Enter).

4. Type Work in the garden.

5. Click the RapidFire button again to turn the RapidFire tool off.

RapidFire icon
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Here’s what the diagram looks like now.

Tip:  If you made a mistake while entering text into a symbol, 
don’t worry. It’s easy to fix. Simply double-click the text in the 
symbol. Then select the words to change and type over them. You 
can also insert text by clicking where you want to make a 
correction and entering the new text.

Adding an unconnected symbol using point 
and type
Sometimes you want to add an idea, but you’re not exactly sure 
where it fits. You can easily add an unconnected idea to a diagram 
using point and type. Inspiration automatically creates a symbol 
to hold the text.

1. Click in the open area in the diagram directly to the right of 
the Career Thoughts symbol. 

2. Type Not in an office.

Inspiration automatically creates a symbol to hold the text. 
This symbol is not linked to any other symbol.

3. Click away from the Not in an office symbol to deselect it.
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Replacing a symbol with one from the Symbol 
palette
Once you get some ideas down, it’s easy to replace a symbol 
already in the diagram with one from the Symbol palette. 
Inspiration offers over 1,300 colorful, high-resolution symbols, 
including several hundred photographic-quality images and 
animated symbols. The symbols are organized into categories and 
libraries.

1. Select the Tinker with cars symbol. 

2. On the Symbol palette, click the Select Library button  to 
navigate to the Everyday category. Choose the Transport 1 
library. 

3. Click the gray car.

The Tinker with cars symbol automatically changes to the 
shape of this car.

Here’s what the diagram looks like now.
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Using drag and drop to add a specific symbol
You can also use drag and drop to add a symbol from the Symbol 
palette to represent a new idea. When you add a symbol using 
drag and drop, the symbol is not connected to any other symbols.

1. On the Symbol palette, click the Select Library button  to 
navigate to the Geography category. Select the Landforms 
library. 

2. Drag the Mountains symbol until it’s positioned above the 
Work in the garden symbol and release the mouse button.
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Linking symbols
Now it’s time to add links. Links show the connections and 
relationships between ideas. 

1. Select the Career Thoughts symbol. This is the symbol where 
the link will start.

2. On the Diagram toolbar, click the Link button to turn on the 
Link tool.

The cursor now looks like this .

3. Click the Not in an office symbol. This is the symbol where the 
link will end. 

A link with the arrowhead pointing to the Not in the office 
symbol appears.

4. Click the Career Thoughts symbol again.

5. Now click the Mountains symbol. 

A second link appears and the arrowhead points to the Moun-
tains symbol.

6. Click the Link button again to turn off the Link tool.
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Here’s what the diagram looks like now.

Adding text on the link
Each link has a text box that appears when the link is selected. 
Adding text to this box defines the relationship between the 
symbols. 

1. Select the link between the Career Thoughts symbol and the 
Mountains symbol, if it’s not already selected.

When a link is selected, you see the outline of the text box 
associated with that link. It’s ready for you to begin typing.

2. Type out of the city. Click off the link to deselect it.
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Here’s what this section of the diagram looks like now.

Adding a note to a symbol
For each symbol in a diagram, a note is available. Notes allow 
you to expand ideas and actually begin the writing process, while 
continuing to work in the visual format. 

1. Select the Mountains symbol. On the Diagram toolbar, click 
the Note button.

A note opens below the symbol.
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2. Type I’d like to live here. into the note.

Moving a note
Because people work in different ways, notes are flexible. After 
you add a note to a symbol, it’s easy to move the note to another 
location on the symbol, or to any open place in the diagram. 

1. Select the open note.

2. Click the note title bar and drag the note so that it touches the 
right side of the Mountains symbol.
Chapter 3: Learning Inspiration, A Tutorial



Here’s what the diagram looks like now.
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Moving symbols
You can also move a symbol to another location in the diagram. 

1. Select the Work in the garden symbol.

2. Drag the symbol so it is directly below Things I like to do, and 
between the Tinker with cars and Fix things symbols. Release 
the mouse button.

Inspiration keeps the link attached so you never lose the con-
nection between ideas when you rearrange the diagram.

Here’s what the diagram looks like now.
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Changing the color of symbols
Color is great for customizing the look of symbols. It helps 
distinguish items in a diagram and is often used to identify a 
group of related ideas. 

1. With the Work in the garden symbol still selected, also select 
the Things I like to do and Fix things symbols. 

To select more than one item, press the Shift key and click 
each item, or click and hold down the mouse to drag a selec-
tion box around the symbols.

2. On the Formatting toolbar, click the Fill Color button and 
choose a color from the palette.

When you change the fill color of a symbol, the color inside 
the symbol changes.

Select a light color, such as light purple. This lets the text con-
tinue to show up nicely against the symbol’s fill color.

3. Click off the symbols to deselect them.

Changing the colors in a multicolor symbol
Changing the colors in a multicolor symbol allows you to further 
customize your work. You can change the colors in any multicolor 
symbol in the symbol libraries.

1. Select the Tinker with cars symbol. On the Formatting toolbar, 
the existing colors in the symbol appear in order of most 
frequently occurring to least frequently occurring. 

2. Click the first color, light gray, and select a new color from the 
palette that matches the look of the other Things I like to do 
subtopics. This color will replace the light gray color that 
appears in the Tinker with cars symbol.

Select the symbol, and then click the 
Fill Color button to choose a new color.
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Saving your work
Whenever you’re working on a document, it’s a good idea to save 
it on a regular basis. To save a document for the first time, or to 
save a document you’ve already saved before under the current 
name, use the Save command.

1. On the File menu, choose Save. The dialog box appears with 
the main idea as the name of the file. 

2. If necessary, navigate to the folder in which you want to save 
the diagram.

3. Click Save. 

In Windows, the file is saved with an .isf extension.

Quitting Inspiration
If you’re ready to take a break from the tutorial, you can quit 
Inspiration after saving your changes. If you want to continue, 
just skip this procedure and turn to the next mini-lesson.

1. To close your file and quit Inspiration, on the File menu, 
choose Quit (Exit). If you’ve made changes to the document, 
Inspiration asks if want to save those changes.

2. Click Yes to save your changes and quit Inspiration. You can 
start again with the next mini-lesson.
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Mini-lesson Two: Outline View
Inspiration’s diagramming and outlining environments are fully 
integrated. While you’ve been creating a visual map of your ideas 
in Diagram View, Inspiration has also been working behind the 
scenes, building an outline of your work.

In this second mini-lesson, you open the diagram created in the 
previous lesson and work with it in Outline View. You will learn 
the following:

• How to switch to Outline View

• How to add a topic

• How to add a subtopic

• How to move a topic by dragging

• How to change the level of a topic

• How to hide and show subtopics and notes

• How to add notes text

• How to change topic defaults

• How to change topic prefixes

• How to print an outline

Tip:  If you quit Inspiration, you need to start the program and 
open the Career Thoughts document.

Switching from Diagram View to Outline 
View
When you switch to Outline View, your information is structured 
in a conventional hierarchy. 

1. Select the Career Thoughts symbol.

2. To view a diagram in Outline View, click the Outline button on 
the Diagram toolbar.
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The diagram is transformed into an outline. The symbols now 
appear as topics and subtopics and the notes text is visible. Even 
though you did not name the Mountains symbol in Diagram 
View, the Picture-to-Topic option automatically provided a label 
for the topic, to ensure you did not lose the relationships between 
ideas when you switched views.

Here’s what your outline looks like now.

Outline toolbar

Formatting toolbar

Subtopic
Quick

Control

Note
Quick

Control

Selection control column
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Adding a topic
You can add a new topic in Outline View as easily as you added a 
new symbol in Diagram View. 

1. If it’s not already selected, select the Career Thoughts topic by 
clicking in the Selection control column. A selection box 
appears around the topic to show it’s selected.

2. On the Outline toolbar, click the Topic button.

Inspiration inserts a new topic and automatically assigns it a 
prefix. The cursor moves to the new line so you’re ready to 
enter text for your new idea. 

3. Type Work outside.

Adding a subtopic
It’s also easy to add new subtopics. These ideas provide 
information subordinate to or supplemental to a topic.

1. With Work outside selected, click the Subtopic button on the 
Outline toolbar.

When you add a subtopic to a topic, Inspiration automatically 
indents it one level below the selected topic and assigns it a 
prefix. The cursor also moves to the new line so you can enter 
text for the new idea. 

2. Type Maybe in a national forest.
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Here’s what this section of the outline looks like now.

Moving a topic by dragging
There are many ways to organize your outline. One of the easiest 
is simply dragging a topic (and its subtopics) up or down in the 
outline. 

1. Select the Not in an office topic.

2.  Drag the topic so it is positioned directly below the Maybe in 
a national forest subtopic. Release the mouse button.

While you drag, the topic remains in its original position until 
you release the mouse button. You can tell where the topic’s new 
location will be by watching the black line as you drag. The small 
arrow on the line indicates the level of the topic’s new location.

The Not in an office topic now appears as a subtopic of Work 
outside, at the same level as the Maybe in a national forest 
subtopic.

Here’s what the outline looks like now.
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Changing the level of a topic
If you decide a topic belongs at a lower level in the outline, it’s 
easy to move it down in the hierarchy.

1. Select the Tinker with cars topic.

2. On the Outline toolbar, click the Right button.

The Tinker with cars topic moves to the right and is now a sub-
topic of Fix things.

Here’s what this section of the outline looks like now.

Hiding subtopics
To make it easier to organize an outline, it’s often useful to hide 
subtopics so you can concentrate on the main topics. 

1. Click the Subtopic Quick Control  to the left of the Things 
I like to do topic. The subtopics for this topic are now hidden.

2. Click the Subtopic Quick Control again to show the subtopics.
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Adding notes text to a topic
Notes text is a good way to further develop ideas in Outline View. 
You can add anything from one sentence to several pages of text.

1. Select the Work in the garden topic.

2. On the Outline toolbar, click the Note button.

The cursor moves to a new line so you can enter the notes text.

3. Type I’ve done some great plant experiments. 

When you add a note, a Note Quick Control  appears in 
the Note control column to the left of the topic. 

Hiding and showing notes text
Just as you can hide and show subtopics, you can hide and show 
notes text. 

1. With the Work in the garden topic selected, click the Note 

Quick Control  to hide the notes text. 

The status of the Note Quick Control changes to show that the 

note is now hidden .

2. Click the Note Quick Control again to show the note.

Setting topic defaults
You can set the defaults for any or all topic levels and notes. The 
default options include font, text size, text color, and other style 
choices. 

1. Select the Career Thoughts topic. On the Formatting toolbar, 

click the Topic Defaults button .

The Topic Defaults dialog box appears.
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2. Select Level 1 and change the color to bright blue. Click 
Preview. 

3. Change the font to Helvetica. Click OK.

Here’s what the outline looks like now.

Changing topic prefixes
You can also change outline prefixes. There are a variety of prefix 
styles available.

1. On the Formatting toolbar, click the Prefix button .

2. Select a new prefix style. 

All of the prefixes in the outline are changed to reflect your 
selection.
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Printing the outline
Before you print the outline, you can determine layout, margins, 
headers and footers, etc. by selecting Page Setup on the File 
menu. Page Setup also allows you to preview the outline before 
printing and, once you’re ready, to print the outline.

1. On the File menu, choose Page Setup.

2. Make your selections and choose Print Preview to preview 
your work.

3. Click Print to print your outline.

Taking a break
If you’re ready to take a break from the tutorial, save your 
changes and quit Inspiration. If you want to continue, just skip 
this procedure and turn to the next mini-lesson.
Chapter 3: Learning Inspiration, A Tutorial



Mini-lesson Three: Returning to Diagram 
View

Since the Inspiration views are fully integrated, when you return 
to Diagram View, you’ll find the diagram has changed to reflect 
the work done in Outline View.

In this final mini-lesson, you return to Diagram View and 
complete the Career Thoughts diagram as you learn each of these 
procedures:

• How to switch to Diagram View

• How to automatically arrange a diagram

• How to change the view scale

• How to position a diagram in the window

• How to change symbol defaults

• How to change the colors of a note

• How to add a hyperlink

• How to record a sound

• How to print a diagram

• How to export a diagram

Tip:  If you quit Inspiration, you need to start the program and 
open your Career Thoughts document.

Switching from Outline View to Diagram 
View
1. Select the Career Thoughts topic, if it’s not already selected. 

2. On the Outline toolbar, click the Diagram button.

The outline is transformed into a diagram. 
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Here’s what the diagram looks like now, including the work done 
in Outline View.
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Arranging the diagram
The Arrange tool arranges a diagram into various formats.

1. On the Diagram toolbar, click the Arrange button.

The Arrange dialog box appears.

2. In the Links list, choose Standard.

3. In the Diagram Type list, choose Top Down Tree. 

4. Click OK.

The diagram automatically rearranges in the new format. 

Here’s what it looks like now.
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Changing the view scale
Magnifying and reducing the view allows you to work with 
specific parts of your diagram or outline, or to see the entire 
screen at one time. To see more of a diagram or outline in the 
window, you zoom out. To make symbols or topics look bigger, 
you zoom in. You can also zoom in or out to a specific percentage. 

1. On the Scroll bar, click the Zoom In button  one time. 
This makes the diagram appear larger on the screen.

2. If you’d like the diagram to appear smaller on the screen, click 

the Zoom Out button .

Positioning the diagram in the window
To work with a specific section of your diagram, you can also 
move the diagram around within the window. 

1. On the Formatting toolbar, click the Position button . 

2. Click and drag the diagram in the direction you want. 

You can click and drag as many times as you need until the 
diagram is where you want it in the window.

3. Click the Position button again to turn the Position tool off.

Changing symbol defaults
Changing the defaults for symbols allows you to easily create 
multiple symbols with the same characteristics.

1. Select the Work outside symbol.

2. On the Formatting toolbar, click the Fill Color button. Select a 
light blue color from the palette.

The color inside the symbol changes to reflect your selection.

Click the Fill Color button to choose a color.
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3. With the Work outside symbol still selected, click the Line 
Color button. Select a dark red color from the palette.

The color of the line around the symbol changes to dark red.

4. On the Formatting toolbar, click the Defaults button . 
Choose Set Default.

5. Now select the Not in an office and Maybe in a national forest 
symbols. 

To select more than one item, press the Shift key and click 
each item, or click and hold down the mouse to drag a selec-
tion box around the symbols.

6. Click the Defaults button , and then choose Apply 
Default. 

These symbols now exhibit the same formatting as the Work 
outside symbol.

Changing the color of a note
Note colors are also changeable, so you can customize them to 
match the symbols.

1. Select the Work in the garden symbol. Click the Note Quick 

Control . 

The note opens.

2. On the Formatting toolbar, click the Fill Color button and 
choose a light purple color from the palette. This will change 
the color inside the note.

Click the Line Color button to choose a color.

Click the Fill Color button to choose a color.
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3. Then click the Line Color button and select a slightly darker 
purple color from the palette to change the color of the line 
around the note. Now the note matches this group of symbols.

Adding a hyperlink
You can further enhance a project by integrating resources from 
the Internet. You can also hyperlink to a document created with 
Inspiration or another application.

1. Select the words “national forest” in the Maybe in a national 
forest symbol.

2. On the Diagram toolbar, click the Hyperlink button.

The Hyperlink dialog box appears.

3. Select Web Page.

The selected text appears in the Hyperlink Text box. 

4. In the Link To box, type http://www.fs.fed.us/. Click OK. 

This creates a hyperlink to the USDA Forest Service web 
page.

5. Click off the symbol to deselect it.

Click the Line Color button to choose a color.
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Here’s what the diagram looks like now.
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Recording a sound
You can annotate diagrams and outlines with recorded comments.

To record sounds, Record Sounds must be made available in 
Application Properties, and your computer must have a 
microphone. You will find Application Properties on the Utility 
menu.

1. Select the Enjoy my job symbol.

2. On the Tools menu, point to Sound, and then click Record.

3. In the recording control box, click Record to begin recording.

4. Say It’s important that I have balance in my life.

5. When you finish recording, click Save. 

The Audio Quick Control  is now displayed next to the 
Enjoy my job symbol. Click the Audio Quick Control to play 
your recorded sound.

To end recording, click Save.

To begin recording, click the Record button.
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Taking a final look
Congratulations! You’ve finished creating your Career Thoughts 
project. 

Here’s one more look at how the diagram appears on the screen.
Inspiration® Getting Started Guide 61



62
Printing the diagram
When you print from Diagram View, the default is Fit to 1 Page, 
which automatically sizes the diagram to fit on one page. If 
desired, this can be adjusted so the diagram prints full size on 
multiple pages.

1. On the File menu, choose Page Setup. 

Here you set up the diagram layout, determine margins, head-
ers and footers, and preview your diagram before printing.

2. Make your selections, and then choose Print Preview to 
preview your work.

3. Click Print to print your diagram.

Exporting the diagram
Once you create a diagram or an outline, you can export it for use 
in a variety of other programs. For example, you can save a 
diagram in graphic file format, which opens in other graphic and 
word processing documents. 

• On the File menu, choose Export and make your selections.

You can also save diagrams as HTML files (also called web 
pages) that can be viewed using a web browser such as 
Netscape Navigator or Microsoft Internet Explorer. Options 
include a single web page or even building an entire web site 
using the Site Skeleton export. To export your diagram as 
HTML files, on the File menu, choose Export as HTML and 
make your selections.

Congratulations! You’re now ready to use the power of visual 
learning to develop all of your great ideas.
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Inspiration Software, Inc. License Agreement

IMPORTANT—PLEASE READ THIS LICENSE AGREEMENT CAREFULLY 
BEFORE OPENING THE SOFTWARE PACKAGE: By opening this Software 
package (package containing the CD), you agree to be bound by the terms and conditions 
of this Agreement. If you do not agree with these terms, promptly return the unopened 
Software package, along with the rest of the package, to the place of purchase for a full 
refund.

This is a legal agreement between you, the end user, and Inspiration Software, Inc. The 
enclosed computer program (“Software”) is licensed, not sold, to you by Inspiration 
Software, Inc. for use under the terms of this license.

GRANT OF LICENSE: Inspiration Software, Inc. grants you the following rights to the 
Software:

Single installation: You may install and use the Software on the temporary memory or 
hard drive or other storage device of any single computer used by one person at a time. You 
must license (purchase) an additional copy of the Software for each additional computer 
on which you want to use it. You must also license (purchase) additional copies of the 
software if the single computer is being used in a server-based computing environment, 
which allows multiple, concurrent users to run a single server.

Multiple licenses: If you have multiple Licenses of the Software, then at any time you 
may have as many computers with the Software installed as you have Licenses. You must 
license (purchase) an additional copy of the Software for each additional computer on 
which you want to use it. 

Ownership: You admit and agree to the validity and enforceability in all respects of any 
copyright of Inspiration Software, Inc. You agree that you will not participate in any attack 
on the validity or enforceability of any of the present copyrights, or potential future 
copyrights of Inspiration Software, Inc. whether in court, the United States Copyright 
Office, or elsewhere except as may be required in response to a subpoena. All rights to the 
Software (including but not limited to any images, photographs, animations, video, audio, 
music, text, examples, templates, symbols and software modules incorporated into the 
Software) are owned or licensed by Inspiration Software, Inc. and are protected by the 
United States and International copyright laws and International trade provisions.

OTHER RESTRICTIONS: You may not:

a) Reverse-engineer, disassemble, decompile, modify or create derivative works of this 
software.

b) Sublicense, rent, loan or lease any portion of the Software or accompanying materials.

c) Use the backup or archival copies of the Software (or allow someone else to use such 
copies) for any purpose other than backup.

You may transfer the Software and the accompanying written materials to a recipient 
provided you retain no copies and the recipient agrees to the terms of this Agreement.

LIMITED WARRANTY: Inspiration Software, Inc. warrants that the media on which the 
Software is recorded will be free of defects in materials and workmanship under normal 
use for 90 days after the date of original purchase. If a defect occurs during the 90-day 
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period, you may return the media (disks or CD) to Inspiration Software, Inc. for free 
replacement. Inspiration Software, Inc. will replace the media, provided that you have 
previously returned the product registration card accompanying the Software to 
Inspiration Software, Inc. Any replacement Software will be warranted for the remainder 
of the original warranty period or 30 days, whichever is greater. These remedies are not 
available outside of the United States of America.

Inspiration Software, Inc. disclaims all other warranties, either express or implied, 
including but not limited to implied warranties of merchantability and fitness for a 
particular purpose, with respect to the product. This limited warranty gives you certain 
legal rights. You may have others, which vary from state to state. In no event will 
Inspiration Software, Inc. be liable to you for damages, whether based on contract, tort, 
warranty or other legal or equitable grounds, including any loss of profits, cost savings or 
other incidental or consequential damages arising out of your use or inability to use the 
Software, even if Inspiration Software, Inc. or an authorized representative of Inspiration 
Software, Inc. has been advised of the possibility of such damage. Inspiration Software, 
Inc. does not warranty that the Software will meet your requirements or that the operation 
of the Software will be uninterrupted or error-free.

GENERAL: This License will be construed under the laws of Oregon, except for that 
body of law dealing with conflicts of law. If there is any dispute under the present 
agreement, you consent to the jurisdiction and venue of all state and federal courts of 
Oregon. If any provision of this License shall be held by a court of competent jurisdiction 
to be contrary to law, that provision will be enforced to the maximum extent permissible, 
and the remaining provisions of this License will remain in full force and effect. If you are 
a U.S. Government user, then the Software is provided with “RESTRICTED RIGHTS” as 
set forth in the sub paragraphs c(1) and (2) of the Commercial Computer Software-
Restricted Rights clause at FAR 52.277-19 or subparagraph c(1)(ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.277-7013, as applicable.
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